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Mercury Marketing Module

The Mercury Marketing module allows you to send direct mail and email marketing promotions to 
your customers. With the upgrade to Mercury Marketing, you can create custom marketing 
campaigns that target a specific set of customers, and use the campaigns to send email messages, 
letters, or postcards to the customers that you already have saved in your FTD Mercury customer 
database.

IMPORTANT If you have yet to purchase the Mercury Marketing module, contact Mercury Technology Sales at 1-800-
767-3222 to learn more about how it can help your marketing efforts!

To automate the marketing process, FTD has provided you with dozens of colorful, professionally-
designed Microsoft Word templates for all occasions, which can be customized to suit your needs. 
You can even create your own custom templates. When your campaign is created, your customer 
information is merged into the templates, and you can print the templates on your own printer, or 
send them to a printer to be printed.

If you plan to send email promotions, FTD has partnered with Constant Contact®, a company that 
maintains an email marketing Web site that is exclusive to FTD florists. Email marketing works by 
first creating your campaign in the Mercury Marketing application, then uploading your customer 
list to the Constant Contact Web site. On the Web site you select the template you want to use, 
schedule when you want the email messages to be sent, and then Constant Contact handles the 
email distribution. Constant Contact keeps all of your customer information confidential, and does 
not use it for any other purpose than for sending your marketing email messages.

NOTE Email marketing distribution is an add-on to the Mercury Marketing module, and is billed separately by 
Constant Contact. You must begin by registering with Constant Contact at http://
ftd.constantcontact.com. Constant Contact manages opt in and opt out and adheres to permission-
based marketing. Neither Constant Contact or the Mercury Marketing module allows you to send 
promotions to purchased lists of customers. You may only send promotions to customers that you have a 
relationship with (customers that are within your database).

Launching the Mercury Marketing Module
TASK To launch the Mercury Marketing module:

1 Open FTD Mercury.
2 Log in using a login name and password that has permission to use Mercury Marketing.
3 On the FTD Mercury Main Menu, click Marketing. The Mercury Marketing Wizard opens, and 

you can begin creating a new campaign or analyzing a campaign you have already executed.
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Marketing Campaigns
Marketing campaigns are promotional campaigns used to send marketing materials to a targeted 
list of customers for a particular occasion or purpose. For example, you can create a Mother’s Day 
letter for top customers, a birthday reminder postcard for all customers, or an Easter email 
promotion for new customers. By prompting you for specific information, the Mercury Marketing 
Wizard can help you create custom marketing campaigns using the data from your FTD Mercury 
customer database. You can then save these campaigns to reuse, edit, analyze, or schedule later.

To make the campaign creation process easy, the Mercury Marketing Wizard provides you with 
predefined campaigns that, when generated, use the marketing templates that FTD has created for 
you. Throughout the campaign creation process you can deviate from the defaults, in which case 
you will be creating your own custom campaign or creating a new marketing template. Below is a 
list of the predefined campaigns that you can create. Templates are located on your hard drive in 
the C:\Wings\Office Marketing Templates directory. You may want to browse this directory and 
open some of the templates to see which ones you might want to use.

Table 16-1: Predefined Campaigns

Campaign Type List Template Description Letter or Postcard

Holiday All Customers
Customers by ZIP 
Code
New Customers
Top Customers

Boss’s Day Reminder to customer for Boss’ Day Both

Christmas Christmas/Seasons’ Greetings letter Both

Easter Easter holiday letter Both

Mother’s Day Mother’s Day promotion/letter Both

Rosh Hashanah Rosh Hashanah letter Both

Secretary’s Day Reminder for Secretary’s Day Both

Sweetest Day Sweetest Day letter Both

Thanksgiving Thanksgiving Day holiday letter Both

Valentine’s Day Valentine’s Day letter Both

Reminder Reminder Anniversary Anniversary reminder, personalized to name, 
recipient, occasion, and date.

Both

Birthday Birthday reminder, personalized to name, 
recipient, occasion, and date.

Both

Special Occasion Generic reminder, personalized to name, 
recipient, occasion, and date.

Both

Reminder—Holiday Holiday reminder 
templates 
(Reminder templates are 
available for all holidays; 
Mother’s Day, Easter, 
etc.)

Reminder to those customers who made 
purchases for recipients on a specific holiday 
last year.

Both

Other Sending florists Sending florists Thank you letter to sending florists Letter only

Dormant Customer Dormant Customer To customers who haven’t purchased in a while, 
personalized to name and last purchase date

Letter only

New Customers New Customers Welcome letter, targeted to new customers Letter only

Recipients Recipients To recipients only Letter only

Top Customers Top Customers Thank you letter to top customers/additional 
promotion

Letter only

All Customers 
Customers by Zip

Generic Can include a custom message Letter only

Open House Generic invitation to visit store. Letter only

Seasonal Promoting seasonal products Letter only
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Creating Direct Mail Marketing Campaigns
Direct mail marketing campaigns are campaigns that you intend to mail to your customers in a 
letter or postcard format. Before you begin, decide your target audience, occasion/purpose, and 
template. Templates are located on your hard drive in the C:\Wings\Office Marketing Templates 
folder. You may want to browse this directory and open some of the templates to see which ones 
you might want to use.

Creating Direct Mail Marketing Campaigns Using Predefined 
Templates

Predefined campaigns are the quickest and easiest campaigns to generate. Most of the information 
is completed for you automatically. Predefined campaigns use existing templates that are already 
created for you with predefined merge fields. Therefore you cannot change the text of the 
template, unless you modify it (see Creating a Single Postcard Template on page 16–13) or create a 
new template (see Creating a New Template on page 16–11).

TASK To create a direct mail marketing campaign using a predefined template:

1 On the FTD Mercury Main Menu, click Marketing. The Marketing Wizard opens.
2 Click Create a New Campaign. The Create Campaign panel appears.
3 In the Campaign Name field, enter a name for your marketing campaign. Remember, this 

campaign can be used later, so make the name as specific as possible. For example, you might 
want to indicate if it is a postcard or letter, and whether the promotion is a reminder campaign 
or a generic one.

4 From the Referral Code list, select the referral code that you want to use for this campaign (or 
add a new one if you do not see one that you want to use). A referral code must be assigned to 
the campaign so that when the customer refers to the campaign, you can select the referral 
code in Order Entry or Point of Sale and later track how effective the campaign was.

5 Select Direct Mail as the Distribution Type.
6 From the Campaign Type list, select the type of campaign. Generally, you will use the Holiday 

or Reminder campaigns. Click Next.
7 The Select Target List panel opens. This panel allows you to select the target list of customers 

that you want to include in this mailing. Click Select a predefined list. This option allows you to 
select predefined customer lists, such as All Customers, New Customers, or Top Customers, or 
if this is a Reminder campaign, you are prompted for the occasion type (Reminder or 
Reminder - Holiday). Selecting a predefined list selects your output fields automatically. You 
will be prompted later in the wizard for some specific criteria, depending on the predefined list 
that you choose (for example, if you select Top Customers, you will later be prompted for the 
number of top customers). Click Next.

8 The Key Criteria panel opens. This panel allows you to select which criteria you want to use 
when selecting the customers to include in your marketing campaign. The options that display 
on this panel depend on which type of customer target list you selected. Provide the 
information that the program is prompting for, depending on the option that you chose in the 
Select Target List window.
Clicking More Criteria allows you to select more criteria for the customer merge. 

NOTE Keep these in mind:

» If you are creating a reminder campaign, you most likely want to select dates for orders that were 
placed last year.

» If you have multiple stores, remember to choose the store that contains the customer records that 
you want to extract. If you select the main store, the program does not extract duplicate customers if 
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you have customers saved at multiple stores. If you extract by Top Customers, the system extracts 
the top number of customers at the selected stores. However because the system is designed to 
eliminate duplicate records, the system eliminates duplicate top customers if the extracted 
customers are top customers at more than one store (therefore you may select to extract 100 top 
customers, but because duplicates are eliminated, only 50 are actually extracted).

9 Click Next.
10 The Output Fields panel opens. Output fields are the merge fields that are inserted into your 

document. Since you are using a predefined list (All Customers, New Customers, etc.), the 
output fields are selected for you. If you want to include more output fields than what are 
displayed in this window, you can click More Fields and select additional fields. Click Next.

11 The Preview and Edit List panel opens. This panel allows you to preview the list of customers 
before you save and execute your campaign. Before reaching the final panel in the wizard, 
review the list and see if you want to remove any customers from the campaign. Any records 
that are highlighted are missing information.

NOTE If you type information in the grid, only the information for this specific customer list is saved (the 
information only is saved in this particular .csv file and is not saved in your customer database).

» To exclude a customer from the list, right-click on the customer record and then click 
Delete Row.

» To view the criteria that you selected throughout the wizard, click View Criteria.

» If you want to change the criteria, click the Back button to go back to previous panel and 
change your selections.

12 Click Next. 
13 On the Save Campaign panel, from the Template list, select the template you want to use. This 

should correspond to the holiday or reminder for which you are creating the campaign. If you 
want to see the template before merging, click Preview. You can change the text of the 
template by clicking the Edit button. Use this option only to change the text of the template.

14 If you want to print post cards, select this option. Postcards are printed four to an 8.5-by-11-inch 
sheet of paper. You also will need to fill in the Return Address area if you create post cards.

15 Select Text Only if you want to use a template that does not have any graphics. The letter is 
printed as formatted text only. This is useful if the paper you are printing on already has 
graphics.

16 In the Sender field, type the name of the person signing the letter or postcard, for example the 
manager or owner of the store.

17 Click Generate Mailing Labels if you want Microsoft Word to generate mailing labels. If you 
select this option, select Three Across.

18 Depending on whether you plan on sending your mailing list to an external printing service or 
whether you are printing the letters or postcards yourself, you can select to open the output in 
Microsoft Word. FTD recommends that if you are using a printing service, you do not select this 
option, and just send the customer file (located in C:\Wings\Customer Lists) and the 
template (located in C:\Wings\Office Templates\Mercury Forms) to the printing service. 
Otherwise, select Open in Word.

19 Select Execute Campaign Now.
20 Click Finish. If you did not select Open in Word, your customer list saves as a .csv file in the 

C:\Wings\Customer Lists directory. The file name is the campaign name followed by the date 
and time that you saved the campaign.
If you selected Open in Word, you receive a message stating that the merge will take a few 
minutes. Click OK. If you are merging a large number of customers, this process takes a few 
minutes. You will not see a progress bar or any indication that the program is working. Please 
be patient until you receive a response from the program letting you know that the merge is 
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complete. When the program is finished with the merge you will receive the message Mail 
Merge Operation completed successfully. The application will now be closed. Click 
OK to complete the process and close Mercury Marketing. Your letters/postcards will display in 
Microsoft Word.

21 To save the letters/postcards, click the File menu, then click Save. FTD recommends saving the 
file in the C:\Wings\Marketing Lists directory, so that you can access the letters by clicking 
the Find my Merged Documents and Mailing Labels on the first panel of the Marketing 
Wizard. Type a name and select a location to save the file, then click Save. 

22 To print the letters/postcards, in Microsoft Word, on the File menu, click Print.

Creating Direct Mail Marketing Campaigns Using Custom 
Templates

If you want to create a custom campaign (i.e., you are not using a predefined list of customers or a 
provided template), you must merge your customer information into Microsoft Word manually.

» To learn how to create a new template (create a template from scratch, including letter text and 
merge fields), see Creating a New Template on page 16–11.

» To learn how to change an existing template (start with an FTD-provided template, then 
change the text and/or merge fields), see Creating a Single Postcard Template on page 16–13.

Creating a Birthday Reminder Direct Mail Campaign
TASK To create a birthday reminder direct mail campaign:

1 Launch the Mercury Marketing module.
2 On the Welcome panel, click Create a New Campaign.
3 In the Campaign Name field, type a name for the campaign (such as Birthday Reminder).
4 Select a referral code for the campaign. If you do not see the referral code you want to use, click 

Add New Referral Code and add it.
5 Select Direct Mail as the Distribution Type.
6 From the Campaign Type list, select Reminder.
7 Click Next.
8 On the Select Target List panel, click Select a predefined list. Select Reminder from the 

predefined list options at the bottom of the panel.
9 Click Next.
10 On the Key Criteria panel, if you have multiple stores, select a store from the Store list.
11 From the Occasion list, select an occasion. In this case, select Birthday.
12 In the Delivery Date field, select a beginning and ending delivery date.
13 Click Next.
14 On the Output Fields panel, review the fields that will be included. Click Next.
15 On the Preview and Edit Lists panel, review the list contents. Click Next.
16 On the Save Campaign panel, in the Template field, select Birthday. If you want to send a 

postcard instead of a letter, click Post Card.
17 In the Sender field, type the name of your shop or the owner name.
18 Select Generate Mailing Labels if you want to generate labels.
19 Select Open in Word.
20 Select Execute Campaign Now.
21 Click Finish.
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The Mercury Marketing Wizard will process your selections. In a few minutes, Microsoft Word will 
open and merge all the customer information into the template. When the merge has finished, you 
can print the letters (or postcards, if you selected Post Card), or save the file to provide to a printing 
service.

Creating a New Holiday Reminder Direct Mail Campaign
The Mercury Marketing module includes several predefined holiday reminder campaigns, 
including templates for letters and postcards. Available holidays include: Boss’s Day, Christmas, 
Easter, Mother’s Day, Rosh Hashanah, Secretary’s Day, Sweetest Day, Thanksgiving, and Valentine’s 
Day.

TASK To create a new reminder campaign for any of these holidays using the included templates:

1 Launch the Mercury Marketing module.
2 On the Welcome panel, click Create a New Campaign.
3 On the Create Campaign panel, in the Campaign Name field, enter your campaign name.
4 Select a referral code for the campaign (or add a new one if necessary).
5 Select Direct Mail as the Distribution Type.
6 From the Campaign Type list, select Holiday.
7 Click Next.
8 In the Select Target List panel, click Select a predefined list, and choose the list you want to 

use from the list at the bottom of the panel.
9 Click Next.
10 The options that display on the Key Criteria panel depend on the list you selected in the Select 

Target List panel. Provide the information requested and click Next.

NOTE If you have multiple stores, remember to choose the store that contains the customer records that you 
want to extract. If you select the main store, the program does not extract duplicate customers if you 
have customers saved at multiple stores. If you extract by Top Customers, the system extracts the top 
number of customers at the selected stores. However because the system is designed to eliminate 
duplicate records, the system eliminates duplicate top customers if the extracted customers are top 
customers at more than one store (therefore you may select to extract 100 top customers, but because 
duplicates are eliminated, only 50 are actually extracted).

11 The Output Fields panel displays all of the output fields that are available for extraction. 
Output fields are the merge fields that will be inserted into your document. Click Next.

12  The Preview and Edit List panel allows you to preview the list of customers before you save 
your campaign. Before reaching the final panel in the wizard, review the list and see if you want 
to remove any customers from the campaign. To do this, right-click on the customer record and 
then click Delete Row. Any records that are highlighted are missing information.

NOTE If you type information in the grid, the information is saved only in this specific customer list (the 
information is saved only in this particular .csv file and is not saved in your customer database).

13 Click Next.
14 On the Save Campaign panel, from the Template list, select the template you want to use. This 

should correspond to the holiday for which you are creating the campaign. If you want to see 
the template before merging, click Preview. You can change the text of the template by clicking 
the Edit button. Use this option only to change the text of the template.

15 If you want to print post cards, select this option. Postcards are printed four to an 8.5-by-11-inch 
sheet of paper. You also will need to fill in the Return Address area if you create post cards.

16 Select Text Only if you want to use a template that does not have any graphics. The letter is 
printed as formatted text only. This is useful if the paper you are printing on already has 
graphics.
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17 In the Sender field, type the name of the person signing the letter or postcard, for example the 
manager or owner of the store.

18 Click Generate Mailing Labels if you want Microsoft Word to generate mailing labels. If you 
select this option, select Three Across.

19 Depending on whether you plan on sending your mailing list to an external printing service or 
whether you are printing the letters or postcards yourself, you can select to open the output in 
Microsoft Word. FTD recommends that if you are using a printing service, you do not select this 
option, and just send the customer file (located in C:\Wings\Customer Lists) and the 
template (located in C:\Wings\Office Templates\Mercury Forms) to the printing service. 
Otherwise, select Open in Word.

20 Select Execute Campaign Now.
21 Click Finish. If you did not select Open in Word, your customer list saves as a .csv file in the 

C:\Wings\Customer Lists directory. The file name is the campaign name followed by the date 
and time that you saved the campaign.
If you selected Open in Word, you receive a message stating that the merge will take a few 
minutes. Click OK. If you are merging a large number of customers, this process takes a few 
minutes. You will not see a progress bar or any indication that the program is working. Please 
be patient until you receive a response from the program letting you know that the merge is 
complete. When the program is finished with the merge you will receive the message Mail 
Merge Operation completed successfully. The application will now be closed. Click 
OK to complete the process and close Mercury Marketing. Your letters/postcards will display in 
Microsoft Word.

22 To save the letters/postcards, click the File menu, then click Save. FTD recommends saving the 
file in the C:\Wings\Marketing Lists directory, so that you can access the letters by clicking 
the Find my Merged Documents and Mailing Labels on the first panel of the Marketing 
Wizard. Type a name and select a location to save the file, then click Save. 

23 To print the letters/postcards, in Microsoft Word, on the File menu, click Print.

Creating Other (Third-Party) Marketing 
Campaigns

If you want to send a mailing to a printing service to distribute for you, FTD recommends that you 
save and send your list (.csv file) of customers only, and not merged into Microsoft Word letters. If 
you merge the list into Microsoft Word letters, the file will be too large to email. Using the Other 
option in the Marketing Wizard allows you to save the .csv file without merging the information 
into Microsoft Word letters.

TASK To create a third-party marketing campaign:

1 Launch the Mercury Marketing wizard.
2 Click Create a New Campaign. The Create Campaign panel opens.
3 In the Campaign Name field, enter a name for your campaign.
4 In the Referral Code field, select the referral code for this campaign (or add a new one).
5 Select Other as the Distribution Type.
6 From the Campaign Type list, select the appropriate campaign type.
7 Click Next.
8 The Select Target List panel opens. On this panel, you select your customer target list. This 

determines the customers that will receive the direct mail promotion. You have several options:
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» Select a predefined list—allows you to select a predefined lists, with output fields 
determined automatically. You are prompted later in the wizard for specific criteria 
(depending on the list you choose).

» Build your own list—allows you to create your own list of customers by specifying a list of 
criteria. Selecting this option prompts you if you want to build your own list By Order or By 
Customer. If you select By Order, you also have the option to select All matching orders or 
Only one order per customer. Selecting Only one order per customer ensures that, for 
example, if John Smith has placed three orders that meet your campaign criteria, his 
information is only extracted once (and therefore only one letter or postcard is printed for 
John Smith).

» Refresh list from a previous campaign—allows you to use a target list from a previous 
campaign, but refresh it to use current information. Click Select to select the campaign that 
you want to use. 

» Load a list from a previous campaign—uses the exact list of customers from a previous 
campaign, without refreshing the list to bring it up to date. Click Select to select the 
campaign you want to use.

9 Click Next.
10 The Key Criteria panel opens. This panel allows you to select which criteria you want to use 

when selecting the customers to include in your marketing campaign. The options that display 
on this panel depend on which option that you selected in the previous panel.
If you selected Build your own list in the previous panel, the Key Criteria panel gives you the 
freedom to specify your own criteria. Select the criteria that you want to apply to the customer 
extraction by clicking on the criteria field, then typing in the key criteria. 
If you selected Select a predefined list in the previous panel, provide the information that the 
program is prompting for in the Key Criteria panel, for example the number of top customers 
or a zip code range. You can click More Criteria to make your customer list more specific by 
selecting more criteria.

NOTE If you have multiple stores, remember to choose the store that contains the customer records that you 
want to extract. If you select the main store, the program does not extract duplicate customers if you 
have customers saved at multiple stores. If you are extracting by Top Customers, the system extracts the 
top number of customers at the selected stores. However because the system is designed to eliminate 
duplicate records, the system eliminates duplicate top customers if the extracted customers are top 
customers at more than one store (therefore you may select to extract 100 top customers, but because 
duplicates are eliminated, only 50 are actually extracted).

11 Click Next.
12 The Output Fields panel opens. This panel lists all of the output fields that are available for 

extraction. Output fields are the merge fields that will be inserted into your document. For 
example, if you want to include the customer’s name and address information at the top of the 
letter, you will want to select the Customer Name, Address, City, State, and Zip fields.
If you selected Build your own list in the Select Target List panel, this panel lists all available 
output fields from which you can. Select an output field by clicking on the field so that a check 
mark appears in the check box.
If you selected Select a predefined list in the Select Target List panel, the wizard lists the 
predefined output fields for you. You can select more output fields by clicking the More Fields 
button.

13 Click Next. 
14 The Preview and Edit List panel opens.This panel allows you to preview the list of customers 

before you save your campaign. Before reaching the final panel in the wizard, review the list 
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and see if you want to remove any customers from the campaign. Any records that are 
highlighted are missing information.

NOTE If you type information in the grid, it only saves the information for this specific customer list (the 
information is only saved in this particular .csv file and is not saved in your customer database).

» To exclude a customer from the list, right-click on the customer record and then click 
Delete Row.

» To view the criteria that you selected throughout the wizard, click View Criteria.

» If you want to change the criteria, click the Back button to go back to previous panels and 
change your selections.

15 Click Next. The Save Campaign panel opens.
16 If you want to execute the campaign now (create the .csv customer list), click Execute 

Campaign Now, or click Schedule to schedule the campaign. If you are scheduling the 
campaign, click Create to create the schedule (see Scheduling Campaigns on page 16–9 for 
details).

17 Click Finish. The campaign saves and you are returned to the Marketing Wizard main panel.
If you selected Execute Campaign Now, your customer list is saved as a .csv file on your hard 
drive of your server in the C:\Wings\Customer Lists directory. The file name is the campaign 
name, followed by the date and time that you saved the campaign. 

IMPORTANT Customer lists (.csv files) should not be viewed in Microsoft Excel (the data may be sorted incorrectly 
when viewing in Excel).

If you scheduled the campaign, the merged letters are saved in the C:\Wings\Marketing 
Lists directory automatically each time they are generated according to the campaign 
schedule.

18 The last step is to email or deliver the customer list to the third party distribution company. To 
email the customer list to the company, open your email inbox and attach the file from the 
C:\Wings\Customer Lists directory.

Scheduling Campaigns
When you save a campaign, you have the option of generating the campaign immediately (saving 
the customer list and/or merging the data into letters), or scheduling the campaign. Creating a 
schedule for a campaign is ideal for campaigns that you intend to run on a regular basis, for 
example monthly anniversary or birthday reminder letters. By creating a schedule, you are giving 
the Mercury Marketing application the information it needs to generate the campaign 
automatically, without you having to access the program.

Before scheduling the campaign, you must first create the campaign in the Marketing Wizard, 
specifying the target customer information (see Creating Direct Mail Marketing Campaigns on 
page 16–3). Before saving the campaign, select Schedule in the Save Campaign window:

TASK To create a campaign that will be generated on a schedule:

1 Create the campaign in the Mercury Marketing Wizard. Ensure you do not save the campaign in 
the last panel of the wizard.

2 Before saving the campaign, select Schedule in the Save Campaign panel. Click Create to 
create the campaign schedule. The Campaign Scheduler opens.

3 Specify the start and end dates for the campaign in the Start Date and End Date fields. This will 
be the period of time the campaign will be generated for you automatically.
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4 Select if you want to run the campaign daily, weekly, monthly, or annually. You are selecting 
how often you want the campaign to be generated. For example, if you select Monthly for a 
date range of April 1 2006 to April 1 2007, a campaign will be generated for each month (12 
campaigns will be generated).

5 If you want to be notified when a list is generated, select the Notify me by E-mail after 
Generating the List and enter your email address in the E-mail field. This email message will 
remind you to distribute the campaign.

6 In the Date Range section, click either Fixed or Floating. The Fixed option should be used for 
non-reminder campaigns that do not require a range of data to be used. For example, if you are 
sending out a yearly Mother’s Day, Easter, Valentine’s Day, etc., campaign, and if your campaign 
is not related to specific order data in your system, select the Fixed option.
The Floating option should be used for reminder campaigns, when the campaign requires a 
range of data (such as orders paced from April 1, 2005 to April 30, 2005). For example, if you are 
sending out a Birthday reminder template and you want to use order information from last 
year’s orders, select the Floating option.

7 Click Generate. The Campaign Scheduler will list your campaign schedule. The Starting and 
Ending columns list the date range that will be used to extract order information. If you 
selected the Fixed option, the Starting and Ending columns will be blank.

8 Click OK to save the information and return to the Save Campaign panel in the Marketing 
Wizard.

9 On the Save Campaign panel, click Finish.

Campaign Analysis
The Mercury Marketing module allows you to analyze marketing campaigns so you can track sales 
generated by your campaigns. Sales that are entered with a marketing campaign’s referral code in 
Order Entry or Point of Sale are sales that are tracked by the Campaign Analysis tool.

NOTE The Campaign Analysis tool only displays orders that were entered in FTD Mercury (Order Entry and 
Point of Sale). To analyze sales statistics for orders that were placed online, go to the Constant Contact 
Web site (http://ftd.constantcontact.com) and run a campaign analysis.

TASK To analyze a campaign:

1 Launch the Mercury Marketing Wizard.
2 On the Welcome panel, click Analyze a Campaign.
3 In the Campaign Analysis window, in the Date Range area, enter the date range in which the 

campaign was run.
4 Click Refresh to list the campaigns that meet the date range you selected.
5 From the results list, select the campaign for which you want to view results.
6 In the Report By area, select whether you want to view the Summary Report (which lists the 

total dollar amount and number of orders that were generated by the campaign) or the Detail 
Report (which lists each individual order that was generated by the campaign).

7 Click View Results. The Mercury Marketing Wizard will generate the report you selected.

Deleting Campaigns
You can delete campaigns from the Campaign Analysis window. 
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TASK To delete a campaign from the Campaign Analysis window:

1 Select the campaign from the list and click Delete. If you do not see the campaign in the list, 
you may have to change the criteria at the top of the panel and then click Refresh.

2 A message appears, warning you if you delete the selected campaign, it will delete other 
campaigns that were run with the same campaign name, including campaign schedules. Click 
Yes to delete the campaign or click No to return to the Campaign Analysis window.

Templates
FTD has provided you with dozens of templates to choose from for direct mail marketing (see the 
list of templates in Marketing Campaigns on page 16–2). These templates can be found in the 
C:\Wings\Office Marketing Templates directory.

Modifying an Existing Template
Modifying an existing template allows you to take advantage of the professional look of the 
predefined template, yet customize it to meet your needs.

This procedure teaches you how to change the merge fields in the template. If you want to only 
change the text in the template, you can do this by clicking the Edit button in the Save Campaign 
panel at the end of the Marketing Wizard.

TASK To change merge fields in a template:

1 Create a marketing campaign using the Marketing Wizard in the Mercury Marketing 
application. However, choose not to open the campaign in Microsoft Word (make sure Open in 
Word is not checked), or if the program asks you if you want to open a new Microsoft Word 
document to begin the merge, click No (you will open the existing template instead).

2 Open the template you want to change. To do this:

a. Open Windows Explorer by right-clicking on the Windows Start button and clicking 
Explore.

b. Navigate to the C:\Wings\Office Marketing Templates folder and locate your template:
c. Double-click on the template to open it.

3 Continue with step 2 in Creating a New Template on page 16–11Creating a New Template on 
page 16–11, changing the text or merge fields in the file as necessary. Make sure that before 
you merge the customer information into the document, save the template using the Save As 
command from the File menu (make sure that you are saving the document as a Document 
Template). It is suggested to save it with the other templates, in the C:\Wings\Office 
Marketing Templates directory.
If you want to change a predefined template permanently, save it using the same file name.

To reuse the template in the future, follow the procedure in this section again; however you will not 
change or rename the file as instructed in step 3 above.

Creating a New Template
Creating a new template from scratch gives you the freedom to create any type of template that 
you want. You can select your own merge fields, type a letter from scratch, then merge the 
customer information extracted from your FTD Mercury database.

Before creating the template, you must extract a customer list (.csv file) so you can merge the 
customer list into the custom template. See Creating Direct Mail Marketing Campaigns Using 
Custom Templates on page 16–5 to create your marketing campaign.
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Your customer list was saved as a .csv file in the C:\Wings\Customer Lists directory on the server. 
This is the file that you need to import into Microsoft Word after you design your new template.

TASK To create a new template:

1 To begin, open Microsoft Word by clicking the Windows Start menu, pointing to All Programs, 
then clicking Microsoft Word. (Microsoft Word may be located in the Microsoft Office folder.)

2 In Microsoft Word, on the Tools menu, point to Letters and Mailings, and click Mail Merge 
Wizard.

3 At the bottom of the right pane, click Next: Starting document.
4 At the bottom of the right pane, click Next: Select recipients.
5 In the right pane, under Use an existing list, click Browse.
6 Navigate to the C:\Wings\Customer Lists folder on the server, highlight the .csv file (the 

customer list that was generated by the campaign in the Mercury Marketing Wizard), then click 
Open.

7 The list of mail merge recipients opens up. These are the customers that met the criteria that 
you specified for the campaign in the Mercury Marketing Wizard. Review the list of customers. If 
you want to remove a customer from the list, click on the check box next to the customer to 
remove the check mark. To help you review the list, you can click on the column headings to 
sort the information. Click OK when you are finished.

8 At the bottom of the right pane, click Next: Write Your Letter.
9 On the blank Microsoft Word document, type your template letter. To insert a merge field, first 

put your cursor in the letter where you want to insert the merge field, then click More items in 
the right pane. A window opens with the available merge fields.

10 To insert a merge field, first make sure that Database Fields is selected at the top of the 
window, then select the merge field and then click Insert. The merge fields display in your letter 
with brackets (<<>>).

11 If you want to insert graphics, do so now. If you have a graphic on file that you want to use (like 
your company logo or letterhead), import that graphic. (On the Insert menu, point to Picture, 
and click From File. Navigate to and select the graphic to import it in your document.)

TIP Microsoft Word comes with clip art that is already installed on your computer. If you want to browse 
through available clip art, on the Insert menu, point to Picture, and click Clip Art. The Insert Clip Art 
pane displays on the right side of the screen. Here you can browse through and select clip art to include 
in your template.

12 Spell check your template. To begin the spell check, on the Tools menu, click Spelling and 
Grammar.

13 When you are finished designing your template, at the bottom of the right pane, click Next: 
Preview your letters.

14 Page through your letters to make sure that the merge appears the way you want. To page 
through the letters, in the right pane, under Preview your letter, click the left and right arrows 
(<< and >>). If you want to make any changes to the template, at the bottom of the right pane, 
click the Previous: Write your letter.

15 When you are ready to merge the customer information, at the bottom of the right pane, click 
Next: Complete.

16 You have two options: Print and Edit Individual Letters. If you want to print the document 
now, click Print. If you want to edit individual letters before you print them, click Edit Individual 
Letters.

17 When the Merge to New Document window opens, select All then click OK to print all of the 
letters. Alternatively, you can just print the current document, or indicate a range of records to 
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print. The letters display in Microsoft Word, where you can page through them and make any 
necessary changes. When you are ready to print them, click File, then click Print.

18 Save the template. If you want to use the template again to reuse later, save the template as a 
Microsoft Word template. To do this:

a. On the File menu, click Save.
b. In the Files of Type field, make sure it reads Document Template.
c. Give the template a name in the File name field, select a location to save the file (it is 

suggested to save it with the other templates, in the C:\Wings\Office Marketing 
Templates directory), then click Save.

Creating a Single Postcard Template
The Mercury Marketing predefined postcard templates are formatted to print four postcards per 
sheet of paper. If you have postcard stock that is formatted for one postcard per sheet of paper, you 
will have to create a new template that is specially formatted to print on your postcard stock paper.

To do this, first extract a customer list (.csv file) so that you can merge the customer list into the 
custom postcard template. See Creating Other (Third-Party) Marketing Campaigns on page 16–7to 
create your .csv file.

Next, follow the steps in Creating a New Template on page 16–11 to create your new template and 
insert your merge fields. However while you are writing your letter in Microsoft Word, format the 
margins of the document so that the template fits on your paper. This involves some trial and error. 
After creating your template, try printing it on your postcard stock paper to see if is aligned 
correctly. You may have to make adjustments so that it prints correctly.

For help on formatting in Microsoft Word, consult your Microsoft Word documentation.

Email Marketing Campaigns
If you have not already considered marketing by email, here are a few reasons why it is more 
efficient and effective than traditional mail marketing—and why it can save you money:

» It is much less expensive—no labor costs or expenses for paper, envelopes and stamps

» It saves time—email marketing campaigns only take a couple of minutes to send, compared 
with the long process of printing, addressing, and mailing letters

» Templates are already created for you—they are colorful, professional, and contain 
personalized customer information

» Email marketing generates an immediate response from your customers—email 
messages can be received by your customers within minutes

» Campaign results are tracked instantly—you can use the Constant Contact Web site to track 
how many customers have placed orders using links in your marketing email messages

» Establish and build relationships—email marketing keeps you in touch with current and 
prospective customers and builds lasting relationships

Creating Email Campaigns in the Marketing Wizard
As you begin creating an email campaign, keep in mind that only customers with email addresses 
are extracted for the campaign.
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TASK To create an email campaign using the Marketing Wizard:

1 On the FTD Mercury Main Menu, click Marketing. The Marketing Wizard opens.
2 Click Create a New Campaign.
3 On the Create Campaign panel, in the Campaign Name field, enter a campaign name. 

Remember that this campaign can be used later, so make the campaign name as specific as 
possible (for example, indicate that it is an email campaign).

4 In the Referral Code field, select the referral code that you want to give the campaign that you 
are creating. A referral code must be assigned to the campaign so that you can track sales that 
were generated by the campaign during campaign analysis.
If you do not see the referral code you want to use, click Add New Referral Code, type the new 
referral code and then click Add. The new referral code is available to use in the Marketing 
Wizard immediately, however you must restart FTD Mercury and Mercury Administration for 
the new referral code to display in those programs.

5 Select Email as the Distribution Type.
6 From the Campaign Type list, select the appropriate campaign type.
7 Click Next.
8 In the Select Target List panel, select the target list for your campaign. Your options are:

» Select a predefined list—This allows you to select a predefined list of either all your 
customers, new customers, top customers, or customers by ZIP code. Select the 
appropriate customer list from the box on this panel.

» Refresh list from a previous campaign—This allows you to use a target list of customers 
from a previously executed campaign, but it also refreshes the data to include any new or 
changed customers that meet the criteria for that campaign. Click Select to select the 
campaign from which the list will be refreshed.

» Load a list from a previous campaign—This loads an exact list of customers that was used 
in a previous campaign. Click Select to select the campaign from which the list will be 
loaded.

9 Click Next.
10 The options that display on the Key Criteria panel depend on the options selected in the Select 

Target List panel. Provide the information requested and click Next.

NOTE If you have multiple stores, remember to choose the store that contains the customer records that you 
want to extract. If you select the main store, the program does not extract duplicate customers if you 
have customers saved at multiple stores. If you extract by Top Customers, the system extracts the top 
number of customers at the selected stores. However because the system is designed to eliminate 
duplicate records, the system eliminates duplicate top customers if the extracted customers are top 
customers at more than one store (therefore you may select to extract 100 top customers, but because 
duplicates are eliminated, only 50 are actually extracted).

11 The Output Fields panel displays all of the output fields that are available for extraction. 
Output fields are the merge fields that will be inserted into your document. Click Next.

12  The Preview and Edit List panel allows you to preview the list of customers before you save 
your campaign. Before reaching the final panel in the wizard, review the list and see if you want 
to remove any customers from the campaign. Any records that are highlighted are missing 
information. 

NOTE If you type information in the grid, the information is saved only in this specific customer list (the 
information is saved only in this particular .csv file and is not saved in your customer database).

» To exclude a customer from the list, right-click on the customer record and then click 
Delete Row.

» To view the criteria that you selected throughout the wizard, click View Criteria.
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» If you want to change the criteria, click the Back button to go back to previous panels and 
change your selections.

13 Click Next. The Save Campaign panel opens.
14 Select Generate Email List Now to save the campaign and generate the .csv customer list now, 

and/or click Schedule to schedule the campaign. If you are scheduling the campaign, click 
Create to create the schedule (see Scheduling Campaigns on page 16–9 for details).

15 If you want to upload the customer file to the Constant Contact Web site now, select Launch 
Constant Contact eMail Marketing Website so that your browser can take you to the Constant 
Contact Web site.

16 Click Finish. The campaign saves and you are returned to the Marketing Wizard main panel.
If you selected Generate Email List Now, your customer list is saved as a .csv file on your hard 
drive in the C:\Wings\Customer Lists directory. The file name is the campaign name followed 
by the date and time that you saved the campaign.

NOTE Customer lists are only saved in the C:\Wings\Customer Lists directory on the server. If you are 
working on a client PC, you must retrieve the .csv on the server PC in that directory. Clicking the Find my 
Previous Lists link does not find the customer list on the client PC. 

IMPORTANT Customer lists (.csv files) should not be viewed in Microsoft Excel (the data may be sorted incorrectly 
when viewing in Excel).

If you Scheduled the campaign, the email messages are sent automatically according to the 
schedule that you specified.

17 The next step is to upload the customer file to the Constant Contact Web site. If you did not 
select Launch Constant Contact eMail Marketing Website to access the marketing Web site 
now, you will later have to go to the Constant Contact Web site at http://
ftd.constantcontact.com to upload the file.

Executing Your Email Marketing Campaign on the Constant 
Contact Web Site

After creating an email marketing campaign within Mercury Marketing, you can upload the 
campaign to the Constant Contact Web site at http://ftd.constantcontact.com to execute your 
campaign.

Email marketing distribution is billed separately by Constant Contact, the company that maintains 
the email marketing Web site. FTD has partnered with Constant Contact to create a seamless email 
marketing Web site for you to use on your own. The Web site includes easy-to-use, professional 
marketing templates for you to use. You simply upload your marketing campaign (customer email 
list) to the Constant Contact marketing Web site, customize the templates, and create a sending 
schedule. The email messages are sent with the information you want to send, when you want to 
send it.

Constant Contact does not allow you to upload third-party customer lists (i.e., lists that you 
purchase). You may only upload lists of customers that you already have a relationship with 
(customers that reside in your database). New anti-spam laws are now in place with penalties. 
Constant Contact is at the forefront of these new laws.

Guidelines for Developing Email Campaign Messages
If you are using email marketing, here are a few things to consider before beginning.
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Maximize Deliverability
» Avoid SPAM trigger words like “discount” and “free” in your email text. These words are SPAM 

(junk mail) triggers and may be caught by some customers’ email filter programs that help 
avoid SPAM. Constant Contact will pre-screen your text and subject lines for trigger words and 
prompt you to change them. If you want to use these words, it is recommended to embed 
them into graphics.

» Use subject lines that will capture attention.

Tips for Writing Content
Although Constant Contact will provide predefined templates on their site, keep these tips in mind 
if you decide to change any of the text. Also, please refer to Constant Contact Central (located upon 
registration on the Constant Contact Web site) for more tips and tricks for creating successful 
campaigns.

» Be short and to the point. Remember email is the fastest growing marketing channel and 
consumer mailboxes are packed.

» Make sure your message is about the customer and what you can do for them. It should be 
more “you” focused than “we” focused.

» Keep the most important part of your message at the top. Avoid making the customer scroll 
down—they may not.

» Before using personalization, take a realistic look at the integrity of the data you are using. Is it 
reliable? If you reference a previous purchase, are you referencing a full product name, or rather 
an abbreviation that will make little sense to your customer?

» Consider customers who share email addresses. What if you reference a gift sent by the 
husband to someone his wife would object to, and they both read the email at the same home 
email address?

» Use of personalization may not improve response across lists. You need to test it with different 
types of customers. If you decide to use personalization, have some targeted letter copy in 
addition to their personalized name.

» People respond to incentives. Test some and incorporate the ones that work into your offers.

Creating a List of Customer Email Addresses
If you want to create a list of customers and their email addresses for other uses, you can do so 
using the Mercury Marketing Wizard.

TASK To create a list of customers and their email addresses:

1 Launch the Mercury Marketing Wizard.
2 On the Welcome panel, click Create a new Campaign.
3 On the Create Campaign panel, in the Campaign Name field, enter a a name for the campaign.
4 From the Referral Code list, select a referral code to use for this campaign. Alternatively, click 

Add New Referral Code to create a new referral code to use.
5 For the Distribution Type, select Direct Mail. (This may seem counterintuitive, but it is the 

correct choice.)
6 From the Campaign Type list, select the appropriate campaign type.
7 Click Next.
8 On the Select Target List panel, select Build Your Own List, and then select By Customer.
9 Click Next.
10 On the Key Criteria panel, ensure all options are cleared and click Next.
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11 On the Output Fields panel, select Customer Name and Customer Email Address. Ensure all 
other options are cleared.

12 Click Next.
13 On the Preview and Edit List panel, review the list of customers and their email addresses. If 

you want to remove a customer from this list, right-click on the customer and click Delete Row. 
When you are satisfied with the list, click Next.

14 On the Save Campaign panel, select Execute Campaign Now.
15 Click Finish.

You will receive a message informing you of the name and location of the file containing the 
customer names and email addresses, which you can open in Microsoft Excel. The files are typically 
stored in C:\Wings\Customer Lists\Customer Lists for Manual Merging.

Mercury Marketing Wizard Reference
The Mercury Marketing Wizard contains the following panels and windows:

» Welcome Panel

» Create Campaign Panel

» Select Target List Panel

» Key Criteria Panel

» Output Fields Panel

» Preview and Edit List Panel

» Save Campaign Panel

» All Campaigns Window

» Add New Referral Code Window

» Campaign Analysis Window

» All Criteria Window

» Selected Criteria Window

» Campaign Scheduler Window

Welcome Panel
When you open the Mercury Marketing module, the Marketing Wizard opens. The first panel in 
the wizard gives you the option of creating a new campaign or analyzing a campaign you have 
already executed.
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Figure 16-1: Welcome Panel

To create a new marketing campaign, click the Create a new Campaign button. The Marketing 
Wizard will take you through the campaign creation process. To analyze a campaign that you have 
already run, click Analyze a Campaign. You will then select the campaign that you would like to 
analyze, and the program will display a sales by referral code report to show you the sales that were 
generated by the campaign.

The links at the bottom of the panel allow you to jump to directories on your computer where you 
have saved customer lists and merged marketing letters. 

The Find my Previous Lists link takes you to the C:\Wings\Customer Lists directory on your 
computer. This is where your customer lists (.csv files) are saved by default. Customer lists are 
generated when you create marketing campaigns. 

NOTE Customer lists are only saved in the C:\Wings\Customer Lists directory on the server. If you are working 
on a client PC, you must retrieve the .csv on the server PC in that directory. Clicking the Find my 
Previous Lists link will not find the customer list on the client PC.

The Find my Merged Documents and Mailing Labels link takes you to the C:\Wings\Marketing 
Lists directory on your computer. This directory is where merged and scheduled marketing 
campaigns are saved by default.

The Find my Pre-Built Templates link opens the C:\Wings\Office Marketing Templates 
directory on your computer. This directory is where you can find your FTD-provided marketing 
templates (*.dot files).

Create Campaign Panel
The Create Campaign panel allows you to enter the name of the new campaign and a unique 
referral code, set the distribution type, and specify the campaign type. You can also load a previous 
campaign to refresh and run it again.
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Figure 16-2: Create Campaign Panel

You can configure the following settings:

Table 16-2: Create Campaign Panel Settings

Setting Description

Campaign Name Enter a unique name for this campaign. This should be easily understandable, for 
example “Mothers Day Email” for a Mother’s Day promotional email message. 
Remember that this campaign can be used later, so make the campaign name as 
specific as possible (for example, indicate that it is an email or direct mail campaign).

If you click Load Previous Campaign, the All Campaigns window opens, 
allowing you to select an existing campaign to load.

Referral Code Select a referral code you will use to differentiate this campaign when customers act 
on it. This will help you determine the campaign’s effectiveness. The Referral Code list 
has several predefined codes.

If you click Add New Referral Code, you can enter a new code to ensure that you 
can determine the impact of this campaign. The new referral code will be available to 
use in the Marketing Wizard immediately, however you must restart FTD Mercury 
and Mercury Administration for the new referral code to display in those programs.
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Click Next to proceed to the Select Target List panel. Click Back to return to the Welcome panel.

All Campaigns Window
This window displays all past campaigns that you have run. To load a campaign, highlight the 
campaign in the list and then click Load.

Figure 16-3: All Campaigns Window

Add New Referral Code Window
The Add New Referral Code window allows you to enter a new referral code for a marketing 
campaign. This code is used to analyze the effectiveness of a particular marketing campaign, and 
therefore, should be unique. Typically, it should also be short so it can be seen in the Order Entry 
and Point of Sale windows.

Distribution Type Select one of the following distribution types:

» Email—Select this option if your marketing campaign will use email messages 
as the distribution method. Email campaigns are quicker and less expensive than 
traditional direct mail campaigns, but you need to collect customer email 
addresses so you can send your message to your customers.

» Direct Mail—Use for physical mail campaigns.
» Other—Select this option if you plan to send the customer list or merged letters 

to a third party company for distribution.

NOTE: If you are creating an email campaign, only customers with email 
addresses will be extracted for your marketing email messages.

Campaign Type Select the campaign type from this list. You can select from the following:

» Holiday
» Reminder
» Other

Table 16-2: Create Campaign Panel Settings (cont.)

Setting Description
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Type the new referral code in the text field then click Add. You will receive a warning message 
stating that you will have to restart the FTD Mercury and Mercury Administration programs for the 
referral code to be visible in those programs. Click OK to accept the message.

Figure 16-4: Add New Referral Code Window

Campaign Analysis Window
So that you can track sales generated by marketing campaigns, the Mercury Marketing application 
allows you analyze marketing campaigns that you have run from the marketing wizard. Sales that 
are entered with a marketing campaign’s referral code in Order Entry or Point of Sale are sales that 
are tracked in the Campaign Analysis window.

Figure 16-5: Campaign Analysis Window

NOTE The Campaign Analysis tool only displays orders that were entered in FTD Mercury (Order Entry and 
Point of Sale). To analyze sales statistics for orders that were placed online, go to the Constant Contact 
website (www.constantcontact.com) and run a campaign analysis.

Complete the following fields on this window:
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» Date Range—Select a date range that the campaigns were run. 

» Report By—Indicate if you would like to view the Summary Report or the Detailed Report. The 
Summary Report lists the total dollar amount and number of orders that were generated by the 
campaign. The Detailed Report lists each individual order that was generated by the campaign.

Click Refresh to list the campaigns that meet the criteria you selected at the top of the window. To 
view campaign results for a campaign, highlight that campaign and then click View Results. Your 
report will display in Microsoft Word.

Deleting Campaigns

You can delete campaigns in the Campaign Analysis window. To delete a campaign, highlight the 
campaign in the list and then click Delete (if you do not see the campaign in the list, you may have 
to change the criteria at the top of the window and then click Refresh). If you delete a campaign, it 
will delete other campaigns that were run with the same campaign name, including campaign 
schedules. Click Yes to delete the campaign or click No to return to the Campaign Analysis 
window.

Select Target List Panel
The Select Target List panel allows you to specify the target audience for the marketing campaign.

Figure 16-6: Select Target List Panel
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You can select from the following options for your target list:

Click Next when you are finished with this panel to move to the next panel of the wizard. 

Key Criteria Panel
The Key Criteria panel allows you to select the criteria you want to use when selecting the 
customers to include in your campaign. The options on this panel depend on the options you 
selected in the Select Target List panel.

Table 16-3: Set Target List Panel Settings

Setting Description

Select a predefined list This option allows you to select a predefined customer list, such as All 
Customers, New Customers, or Top Customers. If you select one of these 
options, later you will be prompted for more specific information, for example 
the number of top customers or a range of ZIP codes.

Build your own list This option allows you to create your own list of customers by specifying a list of 
criteria. Selecting this option will then prompt you if you would like to build 
your own list By Order (in the next panel you will select ORDER fields to extract 
by, such as Delivery Date and Occasion) or By Customer (in the next panel you 
will select CUSTOMER fields to extract by, such as Customer Number and ZIP 
Code).

If you select By Order, you will also have the option to select All matching 
orders or Only one order per customer. Selecting Only one order per customer 
ensures that for example, if John Smith has placed three orders that meet your 
campaign criteria, his information will only be extracted once (and therefore 
only one email will be printed for John Smith).

Refresh list from a 
previous campaign

This option allows you to select a target list of customers from a previous 
campaign and refresh it to take into account any changed data (such as new 
customers or changed customer information) since the list was originally 
generated.

If you select this option, click Select to display the All Campaigns window, 
from which you can select a previous campaign target list to refresh.

Load a list from previous 
campaign

This option allows you to target a list that you have already targeted. The list will 
be exact; it will not be refreshed if the criteria for creating the original list has 
changed. If new orders or customers were saved since the extraction of the 
previous campaign, these orders/customers will NOT be added to your 
customer list.

If you select this option, click Select to display the All Campaigns window, 
from which you can select a previous campaign target list to load.
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Figure 16-7: Key Criteria Panel

If you selected Build your own list in the Select Target List panel, the Key Criteria panel gives you 
the freedom to specify your own criteria. Select the criteria that you would like to apply to the 
customer extraction by clicking on the criteria field, then typing in the key criteria. 
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Figure 16-8: Key Criteia Panel for Build Your Own List

If you selected Select a predefined list in the Select Target List panel, provide the information that 
the program is prompting for in the Key Criteria panel, for example the number of top customers 
or the ZIP code range. You can click the More Criteria button to select more criteria, if you would 
like your customer list to be more specific.

NOTE If you have multiple stores, remember to choose the store that contains the customer records that you 
would like to extract. If you select the main store, the program will not extract duplicate customers if you 
have customers saved at multiple stores. If you are extracting by Top Customers, the system will extract 
the top number of customers at the selected stores. However because the system is designed to 
eliminate duplicate records, the system will eliminate duplicate top customers if the extracted customers 
are top customers at more than one store (therefore you may select to extract 100 top customers, but 
because duplicates are eliminated, only 50 will actually be extracted).

Click Next when you are finished with this panel to move to the next panel of the wizard. 

Output Fields Panel
The Output Fields panel lists all of the output fields that are available for extraction. Output fields 
are the merge fields that you will insert into your template or email. For example, if you want to 
include the customer’s name and address information at the top of a letter, you will want to select 
the Customer Name, Address, City, State, and Zip fields. If you are creating an email campaign, you 
must select an email address for either the customer or recipient (this information must be 
extracted so the email can be sent). You will be warned if an email address is not selected.
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Figure 16-9: Output Fields Panel

If you selected Build your own list in the Select Target List panel, this panel will list all available 
output fields for you to select from. Select an output field by clicking on the field so that a check 
mark appears in the check box.

If you selected Select a predefined list in the Select Target List panel, the wizard will list the pre-
defined output fields for you. You can select more output fields by clicking the More Fields button. 
However, if you do add additional fields, you will deviate from the predefined campaign to the 
point where your campaign is actually a custom campaign. You will then have to use Microsoft 
Word to manually merge fields before you save your campaign.

If you click More Fields, you can select fields to include from the All Output Fields window. Click 
Back to return to the Key Criteria panel; click Next to proceed to the Preview and Edit List panel.

Preview and Edit List Panel
The Preview and Edit List panel allows you to see the target list before you save the campaign. You 
should take this opportunity to verify the list is what you expected. It is possible that you will need 
to click the Back button to change some of the previous options. If you are not sure of the criteria, 
click View Criteria to display the Selected Criteria window.
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Figure 16-10: Preview and Edit List Panel

FTD Mercury automatically highlights entries in the list that may have problems (such as 
incomplete data). You can either fill in or change the data, or you can right-click the row and delete 
the entry entirely. If you elect to modify an entry, it will only be changed for this mailing list and not 
in the customer record.

NOTE Although this panel allows you to type information in the grid, it will only save the information for this 
specific customer list (the information will only be saved in this particular .csv file and will not be saved to 
your customer database).

Click Back to return to the Output Fields panel, or click Next to proceed to the Save Campaign 
panel.

Selected Criteria Window
The Selected Criteria window opens when you click View Criteria in the Preview and Edit List 
panel. This window allows you to see the criteria selected for the campaign. When you close this 
window, you can go back through the Mercury Marketing Wizard to make changes if necessary.



Chapter 16
Mercury Marketing Module

16–28

Figure 16-11: Selected Criteria Window

Save Campaign Panel
The Save Campaign panel allows you to select options for saving your marketing campaign, such 
as whether you would like to execute the campaign now or schedule it, if you would like to 
generate mailing labels, etc. 
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Figure 16-12: Save Campaign Panel

Following are your options in the Save Campaign window (options will vary depending on what 
type of campaign you are creating):

Table 16-4: Save Campaign Panel Settings

Setting Description

Campaign Name This field lists the campaign name that you entered in the first wizard panel. You 
can change it if you wish.

Referral Code This field lists the referral code that you entered in the first wizard panel. You can 
change it if you wish, or click Add New Referral Code to add a new referral 
code.

Generate Email List 
Now

This option is for email marketing campaigns only. Select this option to save the 
campaign and generate the .csv customer list now.

NOTE: Customer lists (.csv files) should not be viewed in Microsoft Excel 
(the data may be sorted incorrectly when viewing in Excel).

Execute Campaign 
Now

This option is for direct mail marketing campaigns only. Select this option to save 
the campaign and merge the letters now.

Schedule Select this option to schedule the campaign.If you are scheduling the campaign, 
click Create to create the schedule.
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The following fields are for direct mail campaigns only:

Click Finish. The campaign will save and you will be returned to the Marketing Wizard main panel.

If you selected Generate Email List Now or Generate Mailing Labels Now, your customer list is 
saved as a .csv file on your hard drive in the C:\Wings\Customer Lists directory (to view the files in 
this directory, navigate to it in Windows Explorer, or click the Find my Previous Lists link in the first 
panel of the Marketing Wizard). The file name will be the campaign name, followed by the date and 
time that you saved the campaign. 

NOTE Customer lists are only saved in the C:\Wings\Customer Lists directory on the FTD Mercury server. If 
you are working on a client PC, you must retrieve the .csv on the server PC in that directory. Clicking the 
Find my Previous Lists link will not find the customer list on the client PC.

Customer lists (.csv files) should not be viewed in Microsoft Excel (the data may be sorted incorrectly 
when viewing in Excel).

If you scheduled the campaign, the merged letters will be saved in the C:\Wings\Marketing Lists 
directory automatically each time they are generated according to the campaign schedule (to view 
the files in this directory, navigate to it in Windows Explorer, or click the Find my Merged 
Documents and Mailing Labels link in the first panel of the Marketing Wizard). If the campaign is 
an email campaign, the emails will be sent according to your schedule.

Table 16-5: Direct Mail Campaign Settings

Setting Description

Template Select the pre-defined template that you would like to use. If you would like to see the 
template before merging, click Preview.

Post Card If you would like to print post cards, this option will print four post cards per 8.5” x 11” 
sheet of paper. If you select this option, make sure post card stock paper is loaded in 
the printer.

NOTE: You can find post card stock paper at your local office supply store, or you 
can order it through FTD Marketplace at 1-800-767-4000.

Text Only Select this option if you would like to use a template that does not have any graphics. 
The letter will be printed as formatted text only.

Sender Type the name of the person signing the letter or postcard, for example the manager 
or owner of the store.

Generate Mailing 
Labels

If you would like Microsoft Word to generate mailing labels, click this option, then 
select Three Across. 

Open in Word If checked, the letters/postcards will open in Microsoft Word when the merge is 
complete. If unchecked, the merge will take place but the document will not open in 
Microsoft Word. The file will be saved in the C:\Wings\Office Templates\Mercury Forms 
directory.

If you plan to send a list and template to a printer, we recommend that you do NOT 
check Open in Word. Just locate the customer file in the C:\Wings\Customer Lists 
directory and locate the template in the C:\Wings\Office Templates\Mercury Forms 
directory and send these to the printer.

Return Address If you are printing post cards, the Return Address section will become active. The 
information you type here will display in the return address section of the postcard. 
Complete the Return Address fields with your shop’s address. 
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Campaign Scheduler Window
When you save a campaign, you have the option of generating the campaign immediately (saving 
the customer list and/or merging the data into letters), or scheduling the campaign. Creating a 
schedule for a campaign is ideal for campaigns that you intend to run on a regular basis, for 
example monthly anniversary or birthday reminder letters. By creating a schedule, you are giving 
the Mercury Marketing application the information it needs to generate the campaign 
automatically, without you having to access the program. The Campaign Scheduler allows you to 
create this schedule.

Figure 16-13: Campaign Scheduler Window

TASK To create the schedule:

1 Specify start and end dates for the campaign in the Start Date and End Date fields. This will be 
the period of time that the campaign will be generated for you automatically. 

2 Select if you would like to run the campaign Daily, Weekly, Monthly, or Yearly. Here you are 
selecting how often you would like the campaign to be generated. 

3 If you would like to be notified when a list is generated, click Notify me by Email after 
Generating the List and type your email address in the Email field. This will remind you to 
distribute the campaign.

4 In the Date Range section, click either Fixed or Floating. The Fixed option should be used for 
non-reminder campaigns that do not require a range of data to be used. For example, if you are 
sending out a yearly Mother’s Day, Easter, Valentine’s Day, etc. campaign and is not related to 
specific order data in your system, select the Fixed option. The Floating option should be used 
for reminder campaigns, when the campaign requires a range of data (such as “orders placed 
from April 1, 2003 to April 30, 2003”). For example, if you are sending out a Birthday reminder 
and you would like to use order information from last year’s birthday orders, select the Floating 
option.

5 Click Generate. The Campaign Scheduler will list your campaign schedule. The campaign will 
be run on the date listed in the Campaign column. The Starting and Ending columns list the 
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date range that will be used to extract order information. If you selected the Fixed option, the 
Starting and Ending columns will be blank.

6 Click OK to save the information and return to the Save Campaign window of the Marketing 
Wizard.

7 Click Finish in the Save Campaign window.

All Criteria Window
The All Criteria window allows you to specify which customers you would like to include in the 
marketing campaign. For example, you may want to only include customers within certain zip 
codes or only customers with a particular billing cycle. 

To select criteria, first click on a field’s check box to select that field, then in the text area type or 
select the criteria for your marketing campaign. When you are finished selecting criteria, click OK to 
return to the Key Criteria panel.


